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Chapter 1
Chapter 1   Introduction
Overview

Note: Unless otherwise noted in this manual, “Control Panel” equally applies to 
either the OGCP-9000 Remote Control Panel rack-mount unit or the Win-
OGCP PC-based application.

This manual supplement provides descriptions and overviews, installation, 
setup, and operating instructions for the Audio Loudness Meter option (+LM). 
This option is installed as a software upgrade to any of several Fusion3G® or 
COMPASS® cards and the OGCP-9000 Remote Control Panel or WinOGCP. 
As such, with the option installed on a Fusion3G® or COMPASS® host card 
(hereinafter referred to as “host card”) and the Control Panel, the option 
provides an audio loudness meter function as described in this supplement. 
Note that the host card and Control Panel retain all of their normal functions; 
the Audio Loudness Meter functions are available as seamlessly added 
submenu selections on the Control Panel.

Note: Host card(s) and control panel(s) use separate option licensing as shown 
below.

This manual supplement consists of the following chapters:

• Chapter 1, “Introduction” – Provides information about this manual 
and what is covered. Also provides general information regarding the 
Audio Loudness Meter option.

• Chapter 2, “Option Installation” – Provides instructions for 
installing and configuring the Audio Loudness Meter option (“+LM”) 
on the Control Panel and host card(s).
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1 Loudness Measurement Overview
• Chapter 3, “Operating Instructions” – Provides overviews of 
operating controls and instructions for using the Audio Loudness 
Meter option.

This chapter contains the following information:

• Loudness Measurement Overview (p. 1-2)

• Audio Loudness Meter Functional Description (p. 1-5)

• Technical Specifications (p. 1-10)

Loudness Measurement Overview

ITU-R BS.1770-1 – ATSC A/85 Overview

Note: Refer to ITU-R BS.1770-1, “Algorithms to measure audio programme loud-
ness and true-peak audio level” and ATSC A/85, “ATSC Recommended Prac-
tice: Techniques for Establishing and Maintaining Audio Loudness for Digital 
Television” for more information.

This option provides an Audio Loudness Meter that performs loudness 
measurement based on the methods described in ITU-R BS.1770-1 and ATSC 
A/85. This recommendation considers the L, R, C, Ls, and Rs audio inputs of 
a 5.1-channel complement and performs a measurement on each channel that 
sums the weighted acoustical energy present in each channel over a given 
sampling period (see Figure 1-1). These individual channel measurements are 
summed, resulting in a single, overall numerical quantity (called “LKFS”; as 
defined as loudness, K-weighted, relative to full scale) which can be used as a 
pass/fail value of the program material when assessed against a target LKFS 
value. Note that stereo and monaural sources can also be used; however, LFE 
and auxiliary channels are never included in an LKFS assessment.
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Introduction Loudness Measurement Overview
Figure 1-1  ITU-R BS.1770-1 Basic Audio Loudness Measurement Model 

When a piece of material is assessed from start to finish for LKFS 
compliance, this is called a session. The Audio Loudness Meter provides 
LKFS indications showing both short-term trends and an overall session 
LKFS. (The distinctions between these methods are described in detail later in 
this chapter.) LKFS measurements are expressed in decibels. As such, gain 
changes to program material have a direct effect on LKFS measurement.

The LKFS value for a given audio segment very closely mimics the perceived 
human psycho-acoustical loudness for the segment. This loudness 
measurement model tends to consider not only peak level, but more 
importantly the acoustical energy over a specific sampling period. In this 
manner, a high-amplitude, short-duration event may score a lower LKFS 
value than a lower-amplitude, long-duration event.
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Using the expression shown below, each channel’s hi-pass filtered contribution (y) to relative acoustical energy is calculated for period T. 

Noting the above, it becomes apparent that the resulting LKFS value for a given input is not exclusively related to maximum or 
instantaneous signal level (as per peak and/or VU values). Rather, for two audio segments of the same frequency, a segment with a 
lower peak amplitude (but greater duration) will in some cases result in greater acoustical energy than a higher-amplitude, 
same-frequency segment having a shorter duration due to the function’s summation of “area under the curve” versus simple peak level.
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1 Loudness Measurement Overview
EBU R 128 Overview

Note: Refer to EBU – Tech 3343, “Practical guidelines for Production and Imple-
mentation in accordance with EBU R 128” for more information.

EBU R128 is based on ITU-R BS.1770-1 and therefore uses the same signal 
processing scheme. However, EBU R 128 is different from ITU-R BS.1770-1 
as follows:

• EBU R 128 uses either of two scales (“EBU +9” and “EBU +18”) 
wherein 0 LU is equivalent to the absolute unit of -23 LUFS used in 
ITU-R BS.1770-1. As such, the EBU +9 scale is functional from a 
range of -18.0 LU to +9.0 LU (-41 LUFS to -14 LUFS), and the 
EBU +18 scale is functional from a range of -36.0 LU to +18.0 LU 
(-59 LUFS to -5 LUFS).

• EBU R 128 uses a gating scheme in which levels below the gating 
threshold (typically -8 LU below the target level) are rejected from 
the session measurement. As such, there is not a loudness “budget” 
where low levels can artificially influence the overall assessment in 
the measurement.

• EBU R 128 uses three distinct averaging periods, with measurement 
values provided for each simultaneously. The three periods are 
intended to help in better adjusting post-production loudness to best 
meet the overall desired performance.

• Momentary (M) loudness uses a time window of 400 msec.

• Short-term (S) loudness uses a time window of 3 seconds. 

The M and S measurements are suited for assessing immediate 
leveling of loudness, ideally bringing the anchor element of the 
material as close to the -23 LUFS Target Level as possible.

• Integrated (I) loudness is the measurement performed over the 
course of the entire session. Following tailoring of basic leveling 
considering M and S as described above, properly produced 
material or material using automated loudness-processing (such as 
provided by option +LP51 or LP20) should conform to the -23 
LUFS Target Level (or 0 LU in the normalized EBU R 128 
method).
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Introduction Audio Loudness Meter Functional Description
Audio Loudness Meter Functional Description

Audio Loudness Meter Option System Interface

Identical to the interface between the Control Panel and Fusion3G® or
COMPASS® card in a network-controlled frame, the Audio Loudness Meter 
option is used in conjunction with a Cobalt® OGCP-9000 Remote Control 
Panel and/or WinOGCP (which provides all user interface functions), and a 
host card which serves to monitor the intended audio signals and provides 
LKFS data to the Control Panel. As such, the host card monitors selected 
audio channels and applies signal analysis based on ATSC A/85 or 
EBU R 128 criteria to produce an LKFS measurement and provide data indi-
cating under-threshold and over-threshold level conditions. In turn, the card 
sends data packets to the Control Panel indicating the measurements per-
formed by the card. Note that multiple host cards can be accommodated by a 
single Control Panel.

The Control Panel in turn displays the loudness information. The Control 
Panel also generates packets based on user control inputs which control 
operation of the host card(s), as well as dictates parametric user settings to the 
host card(s). The host card(s) and the Control Panel communicate over a 10/
100-T LAN, with the host card(s) supported by a frame equipped with a 
Network Controller card.

Audio Loudness Meter Signal Processing

Note: Audio input format accommodation is a function of the host card. Discussion 
here describes all available audio inputs. On host card additionally equipped 
with an optional Dolby® decoder, the Audio Loudness Meter can perform 
measurements on decoded Dolby E or AC-3 data.

(See Figure 1-2.) The Audio Loudness Meter option uses measurement data 
sent by the host card representing loudness measurement and discrete signal 
levels of channels selected for metering on the host card. Where supported by 
a host card licensed for loudness processing (option +LP51 or +LP20), 
measurement data can include both pre-processed and post-processed 
Loudness Processor inputs (only Fusion3G® cards support pre-processed 
measurement). Note that the full 5.1 channel complement and assignable 
AUX channels are displayed as confidence monitors using PPM meters; 
however, the LFE and AUX channels are not included in any loudness 
measurement calculations or display. 

The session monitored by the operator is time-stamped using NTP time 
(where configured) and material timecode (as selected from the timecode 
format outputted by the host card). Concurrently displayed is session elapsed 
time, with any errors logged using a session elapsed time stamp (which starts 
at 00:00:00:00 (hr:min:sec:tenths)).
OPT-SW-LM-MS  (V2.9) AUDIO LOUDNESS METER OPTION (+LM-C, +LM-P) MANUAL SUPPLEMENT 1-5



1 Audio Loudness Meter Functional Description
The host card output timecode (as selected via the host card timecode 
controls) is used by the Audio Loudness Meter for additional time stamp 
purposes and for timecode-controlled session automation (session start/stop 
based on timecode range). The Audio Loudness Meter generates session 
reports (as both .html and .csv) that are available via the network-connected 
PC(s). 

Figure 1-2  Audio Loudness Metering Host Card/Loudness Meter Interface Block Diagram
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Introduction Audio Loudness Meter Functional Description
Aggregate LKFS Processing

Short-Term LKFS Calculation

(See Figure 1-3.) The LKFS values for the individual inputs comprising the 
LKFS monitor/measurement display channels are processed and summed as 
described in Loudness Measurement Overview (p. 1-2) for a given sampling 
period. This sampling is repeated, with each resulting value continuously 
re-averaged with previous values resulting in a short-term moving average 
LKFS value. This process is shown and described in Figure 1-3.

A dedicated bar graph with a 0 to -70 LKFS scale displays this constantly 
updating value. At any point where LKFS is under or over target by a 
configurable threshold, the display respectively changes either blue or red; 
measured LKFS values within the target thresholds are displayed in white.

Figure 1-3  Short-Term LKFS Value Calculation and Typical Display

t (sec)

Short-Term Calculated LKFS Value
In this example, the last 3 measurement periods are averaged in each reported LKFS value. This cycle is repeated as 
long as the session is allowed to run. The Moving Average Period parameter sets the sampling time accumulated before 
each averaging recalculation.

Session

1st Report

2nd Report

3rd Report

While a session is being run, the Short-Term LKFS display shows 
short-term moving average LKFS numeric value and status. The 
accompanying bar graph display shows LKFS change trends. The 
bar graph display shows blue, green, or red segments to indicate 
deviation from configured thresholds (in this example, red segment 
indicating short-term LKFS running HI).
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1 Audio Loudness Meter Functional Description
Session LKFS Calculation

(See Figure 1-4.) A session-duration calculation/display (sometimes referred 
to as “infinite-duration) is numerically displayed. This is defined by the 
averaged sum of all short-term samples in the session, concluding when the 
session is stopped. 

Figure 1-4  Session LKFS Value Calculation

t (sec)

Session

• • •

Final Report

Session LKFS Value
Session LKFS value is the average of all short-term measurements of a particular session. The measured value can be 
considered final when the session has been stopped.

When the session is concluded, the final session LKFS value and 
accept/reject status is displayed and held. At the end of a session, 
this display shows the session-duration value over the course of 
the entire session (excepting any intervals when pause was 
effected). End of session LO LKFS or HI LKFS assessment is 
denoted by blue or red characters. 
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Introduction Audio Loudness Meter Functional Description
Configurable LUFS/LKFS HI/LO Alert Parameters

The Audio Loudness Meter offers configurable alert thresholds at which a 
measured LUFS/LKFS result can be considered unacceptably above or below 
a target value. These alerts in turn can provide consistent and unambiguous 
go/no-go results for a loudness session with no interpretation of quantitative 
results required on the part of the QC operator. The Audio Loudness Meter 
uses the criteria described below for configuring limits and in turn displaying 
LUFS/LKFS errors within a session.

• HI threshold – This is the maximum level above the target level, 
where exceeded, results in a displayed LUFS/LKFS violation for the 
duration of the event. This condition results in a violation regardless 
of the duration of the event.

• LO threshold – This is the minimum level, where exceeded, results 
in a displayed LUFS/LKFS violation for the duration of the event. 
This condition results in a violation regardless of the duration of the 
event. This parameter is optional and default set to disabled.

Note: The error threshold settings described here affect only admin-configurable 
error flagging in displays and logs furnished by the Audio Loudness Meter (for 
example, HI and LO errors). These threshold settings are wholly independent 
of the LUFS/LKFS measurement function. As such, resulting numerical 
short-term and session LUFS/LKFS values displayed for a session are not in 
any way affected by these threshold settings.

Session Time Markers and Sources

The Audio Loudness Meter option correlates points between the start and stop 
of a session using session elapsed time (starting at 00:00:00) which is 
correlated to local time (from NTP server, for example) and timecode data 
extracted from the session program material. When used with an SDI input, 
the Audio Loudness Meter option extracts (where available) SDI VITC 
waveform, SDI ATC_VITC, and/or SDI ATC_LTC timecode streams from 
the SDI signal to identify locations within the monitored program material.

Session and local time is recorded and displayed in hrs:min:sec:tenths; 
material extracted timecode is recorded and displayed in hrs:min:sec:frames. 

Log Reports

Log reports are saved after each session. HTML log reports can be accessed 
and displayed via a web browser pointing to the Control Panel. Similarly, .csv 
reports can also be accessed (WinOGCP only. The report can then be 
manipulated just as any other web page (i.e., used for copy/paste, printed, or 
saved as a file).
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1 Technical Specifications
Audio and Video Formats Supported by the Audio Loudness Meter

Refer to the Product Manual for the host card for audio and video formats 
supported.

Technical Specifications

Note: • Refer to the Product Manual for the host card for technical specifications of 
the audio and video formats supported.

• Refer to Product Manual “OGCP-9000 Remote Control Panel Product 
Manual” (PN OGCP-9000-OM) for technical specifications for the Control 
Panel.

• Refer to Product Manual “WinOGCP Desktop Virtual Control Panel Product 
Manual” (PN WINOGCP-OM) for technical specifications for the WinOGCP 
Control Panel.

Table 1-1 lists the technical specifications for the Audio Loudness Meter 
option.

Table 1-1 Technical Specifications

Item Characteristic

Part number, nomenclature Software option +LM

Host Card Compatibility Suitable for use with Cobalt® Fusion3G® or COMPASS® cards equipped with 
+LM licensed feature that process and/or output embedded and/or AES digital 
audio

Loudness Metering Modes • ITU-R BS.1770-1 / ATSC A/85; fixed target of -24 LKFS (ATSC -24)

• EBU R 128 “+9 EBU” and “+18 EBU”; fixed target of -23 LUFS

• Custom (configurable target LUFS/LKFS; configurable gating / no gating)

dBFS Scale Range 0 to -70 dBFS; absolute or configurable relative

LKFS Scale Range 0 to -70 LKFS

Averaging Simultaneous session and short-term; configurable short-term moving 
averaging period

Audio Inputs 8-channel confidence monitoring; 5-channel (L, R, C, Ls, Rs) loudness 
assessment per ATSC A/85 or EBU R 128. 
Accommodates embedded, AES, analog, decoded Dolby® E/AC-3 audio (per 
host card capabilities).

Signal-Level Triggering Configurable independent start and stop signal level thresholds; 0 to -60 dBFS

Timecode Triggering Configurable independent start and stop timecode marks using timecode format 
being used by +LM option

Clock Sources (OGCP-9000) Accommodates network time server or local (internal) sources.
(WinOGCP) Uses PC clock.

Communication 10/100 Mbps Ethernet between Control Panel and host card in openGear™ 
frame
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Chapter 2
Chapter 2   Option Installation

Overview
Note: In this chapter, “Control Panel” means the instruction is applicable for either 

an OGCP-9000 Remote Control Panel rack-mounted unit, or the PC-based 
WinOGCP virtual control panel. Where instructions are different for the 
OGCP-9000 Remote Control Panel and WinOGCP, this is noted.

Typically, a Control Panel and host card(s) must be set up for this option using 
the instructions in this chapter. Please contact Cobalt Digital Inc. Technical 
Support with any questions.

Prior to using this option for loudness metering:

• The Control Panel and host card(s) must be visible to each other over 
the LAN, and 

• Control Panel and host card(s) must have respective +LM-P and 
+LM-C option feature keys activated on each device (i.e., control 
panel and host card) to be used with the option. 

Note: Host card(s) must be installed in a frame equipped with the optional 
MFC-8310-N or MFC-8320-N network controller card installed.

This chapter contains the following information for installing the +LM option 
on the Control Panel and host card(s):

• Connecting Control Panel to LAN and Host Card Frames (p. 2-2)

• Activating Audio Loudness Meter Feature Keys (p. 2-2)

Note: WinOGCP has a control layout largely identical to that of the OGCP-9000 
Remote Control Panel rack-mount unit. The “knobs” on WinOGCP (as 
compared to the physical knobs on OGCP-9000) operate as described below.

To “rotate” a WinOGCP “knob” counter-clockwise (CCW), 
place the cursor over the desired knob and roll the mouse 
track wheel up.

Roll the mouse track wheel down for CW.
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2 Connecting Control Panel to LAN and Host Card Frames
Connecting Control Panel to LAN and Host Card Frames
Instructions here assume that the Control Panel is connected to the LAN and 
host card frames. If this is not already done, refer to the OGCP-9000 or 
WinOGCP Product Manual as appropriate. 

Activating Audio Loudness Meter Feature Keys
Feature keys must be activated on both the OGCP-9000 Remote Control 
Panel(s) and/or WinOGCP, and the host card(s) that are to be used for this 
option. Activate feature keys as described below.

Activating the Audio Loudness Meter Feature (+LM-C) on Host Card(s)

1. On the host card where the feature is to be activated, open the 
Licensable Feature tab in DashBoard™. Follow the instructions below 
to activate your licensable feature.

2. Repeat for any other host cards as required.

Licensable Features

Allows activation of optional licensed features.

Note: For card pre-ordered with licensed feature(s), the activation steps described below are not required; the feature will 
already be installed activated. To order features and obtain a license key, contact Cobalt® sales at 
sales@cobaltdigital.com or at the contact information in your product manual. Please provide the “SSN” number or 
Serial Number of your card (displayed in the Card Info pane) when contacting us for your key.

• License Feature and Key Entry window Activate licensable feature as described below.

1. Enter the feature key string in the Feature Key box. Press return or 
click outside of the box to acknowledge entry.

Note: Entry string is case sensitive. Do not enter any spaces.

2. In the DashBoard™ Card Info pane, wait for Valid Key Entered to be 
displayed. This indicates the key was correctly entered and recognized 
by the card.

Note: If DashBoard™ card option submenu/control pane does not 
re-appear, close the card and re-open it.

3. Click and confirm Reboot. When the card option submenu/control pane 
appears again, the licensable feature will be available. (The Loudness 
Metering tab now appears in DashBoard along with other card menu 
tabs.)

4. Note: Applying the licensable feature and its reboot has no effect on 
prior settings. All control settings and drop-down selections are 
retained.
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Option Installation Activating Audio Loudness Meter Feature Keys
Activating +LM-P Audio Loudness Meter Option on OGCP-9000 Remote Control Panel

Each Control Panel running the Audio Loudness Meter option must have the 
Audio Loudness Meter licensable feature installed and activated. Install and 
activate the feature as described below.

Note: OGCP-9000 Remote Control Panels using the current version of option 
+LM-P require that the control panel has a software build that supports this 
option.

The control panel must be loaded with Processor Version 1012 or greater 
before proceeding. From the Cobalt Digital Inc. web site, go to Support > 
Firmware to download the current firmware, as well as instructions.

Note: In performing this procedure, you will need to contact Cobalt Digital Inc. to 
receive the feature key string for your Control Panel if not already done. Each 
Control Panel has a unique feature key string. If it is not convenient to contact 
us at this time, this procedure can be deferred until convenient. 

1. On the Control Panel keypad, press Select Device and select
0 This Control Panel.

2. Using any knob or the Select Submenu key, select Licensed Features.

3. Note the Hardware ID now displayed on the Control Panel. Call Cobalt 
Digital and provide this number to receive your feature key. You will be 
given a 10-digit decimal string that is your feature key.

Note: • If the string contains leading zeros, these must also be entered. String must 
be 10 digits.

• If the string is mis-entered, the entered string value appears in red. Press 
Cancel and re-enter the string.

4. Enter the 10-digit string using the Control Panel numeric keypad, and 
then press Enter. After pressing the Enter key, the correct entry and 
feature acknowledgement is displayed as shown in the example below.

5. Press Select Device. The Control Panel now saves the changes, restarts, 
and then displays the Audio Loudness Meter screen.

6. Repeat for additional Control Panels as required.

Loudness Meter
4144600267
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2 Activating Audio Loudness Meter Feature Keys
Activating +LM-P Audio Loudness Meter and Other Options on WinOGCP

Each instance of (or machine running) WinOGCP running the Audio 
Loudness Meter option must have the Audio Loudness Meter licensable 
feature installed and activated. Install and activate the feature as described 
below.

Note: WinOGCP using the current version of option +LM-P require that the applica-
tion has a software build that supports this option.

WinOGCP must be loaded with Application Build 1054 or greater before 
proceeding. From the Cobalt Digital Inc. web site, go to Support > Firmware 
to download the current firmware, as well as instructions.

Note: In performing this procedure, you will need to contact Cobalt Digital Inc. to 
receive the feature key string for your Control Panel if not already done. Each 
WinOGCP has a unique feature key string tied to the MAC address hosting 
WinOGCP. If it is not convenient to contact us at this time, this procedure can 
be deferred until convenient. 

1. On WinOGCP, click on Select Device and select
0 This Control Panel.

2. Using any knob or the Select Submenu key, select Licensed Features.

3. Note the Hardware ID now displayed on WinOGCP. Call Cobalt Digital 
and provide this number to receive your feature key. You will be given a 
10-digit decimal string that is your feature key.

Note: • If the string contains leading zeros, these must also be entered. String must 
be 10 digits.

• If the string is mis-entered, the entered string value appears in red. Press 
Cancel and re-enter the string.

4. Enter the 10-digit string using the WinOGCP numeric keypad, and then 
click Enter. After clicking Enter, the correct entry and feature 
acknowledgement is displayed as shown in the example below.

5. Click Select Device. WinOGCP now saves the changes, restarts, and 
then displays the Audio Loudness Meter device choices (cards/slots 
hosting Loudness Metering as defined in configuration file).

6. Repeat for additional WinOGCP instances as required.

Loudness Meter
4144600267
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Chapter 3
Chapter 3   Operating Instructions

Overview
This chapter contains the following information:

• Audio Loudness Meter Measurement Modes (p. 3-2)

• Live Data Display (Left Display) and Display Formats (p. 3-3)

• Session Control (Right) Display (p. 3-5)

• Setting Up the Audio Loudness Meter (p. 3-6)

• Session Setup (p. 3-16)

• Post-Session Reports (p. 3-18)

• Troubleshooting (p. 3-22)

Note: • In this chapter, “Control Panel” means the instruction is applicable for either 
an OGCP-9000 Remote Control Panel rack-mounted unit, or the PC-based 
WinOGCP virtual control panel application/host computer. Where instruc-
tions are different for the OGCP-9000 Remote Control Panel and WinOGCP, 
this is noted.

• Refer to “OGCP-9000 Remote Control Panel Product Manual” (PN 
OGCP-9000-OM) for general operating instructions on using the Control 
Panel keypad, knobs, and displays.

• WinOGCP has a control layout largely identical to that of the OGCP-9000 
Remote Control Panel rack-mount unit. The “knobs” on WinOGCP (as com-
pared to the physical knobs on OGCP-9000) operate as described below.

To “rotate” a WinOGCP “knob” counter-clockwise (CCW), 
place the cursor over the desired knob and roll the mouse 
track wheel up.

Roll the mouse track wheel down for CW.
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3 Audio Loudness Meter Measurement Modes
Audio Loudness Meter Measurement Modes
Table 3-1 lists and describes the measurement modes available for the Audio 
Loudness Meter option. The EBU +9, EBU +18, and ATSC -24 modes are 
factory configured with all parameters conforming to the respective standard 
and are ready for immediate use (requiring only input channel assignment for 
use).

Audio Meter Displays
(See Figure 3-1) The Audio Loudness Meter option uses the two displays of 
the Control Panel as follows:

• Left display panel is live data display. Refer to Live Data Display 
(Left Display) and Display Formats (p. 3-3) for more information.

• Right display panel is session control display. Refer to Session 
Control (Right) Display (p. 3-5) for more information.

Table 3-1 Audio Loudness Meter Measurement Modes

Mode Description and Parametric Settings

Note: Refer to ATSC A/85, “ATSC Recommended Practice: Techniques for Establishing and Maintaining Audio Loudness 
for Digital Television” or EBU – Tech 3343, “Practical guidelines for Production and Implementation in accordance 
with EBU R 128”, as applicable, for full details regarding audio loudness measurement and assessments using 
these standards.

EBU +9
EBU +18

• EBU R 128 “+9 Scale” or EBU R 128 “+18 Scale” standards.
• Normalized 0 LU ref. to -23 LUFS.
• Usable range is +9.0 to -18.0 LU (EBU +9) and +18.0 to -36.0 LU (EBU +18).
• Uses a fixed target value of -23 LUFS (0 LU).
• Gating is applied in which levels below the gating threshold (-8 LU below the target 

level) are rejected from the session measurement. Measurement parameters include 
fixed Momentary (M) sampling over 400 msec intervals, Short-Term (S) sampling over 
3 sec intervals, and Integrated (I) sampling over the entire session.

ATSC -24 • ITU-R BS.1770-1 – ATSC A/85 standard.
• Normalized 0 LU ref. to -24 LKFS
• Uses a fixed target value of -24 LKFS. 
• Gating is not used; all measured values are included in short-term and session LKFS. 

Custom Provides full parametric user configurability to be set as modified EBU R 128 or
ATSC A/85 mode.
Note: Custom mode configured with user settings may not be compliant with EBU R 128 
or ATSC A/85 standards.

Configurable parameters are as follows:
• Target LUFS/LKFS
• Units (LKFS/LUFS)
• Units absolute or relative ref. configured target LUFS/LKFS
• Moving average period (default= 3 sec)
• EBU relative gating (disable/enable) and gating threshold
• Viewable range
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Operating Instructions Audio Meter Displays
Figure 3-1  Audio Loudness Meter Left and Right Displays

Live Data Display (Left Display) and Display Formats

The Audio Loudness Meter has two user-selectable primary metering display 
formats for the live data (left) display:

• Real-Time Bar Graph Format Left Display (Figure 3-2)

• Graphing Format Left Display (Figure 3-3).

Figure 3-2  Real-Time Bar Graph Format Left Display

Input Channel PPMs Short Term LKFS Display

Item Function
Format Select Control Rotating this knob toggles the left display between Real-Time Bar Graph Format described here 

and Graphing Format described on the next page.

Input Channel PPMs 
(Peak Program Meters)

Shows input signal levels (with configurable channel level alert (yellow) and over-level (red) input 
level thresholds. A configurable true-peak over-level alert (orange circle icon) is provided for each 
channel, using a 1-second hold/refresh interval. Running peak level for each input channel is 
shown by orange bar.

This pane is continuously shown and displays live signal levels regardless of whether or not a 
session is running, paused, or stopped. 

Short Term LKFS Display Shows short-term, running average LKFS value and status. The accompanying bar graph display 
assists in displaying LKFS change trends. The bar graph display changes to red, green, or blue bar 
to readily indicate deviation from configured thresholds (in this example, short-term LKFS running 
HI).

Real-Time Bar Graph Format displays 
channel PPM in real time and short-term 
loudness. This is best suited where 
individual channel level analysis is of 
primary concern, with the loudness trend of 
secondary concern.

Format Select Control
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3 Audio Meter Displays
Figure 3-3  Graphing Format Left Display

Origin (Real-time)

Look-Back

Short-Term 
Avg Plot

Short-Term Min/Max
Envelop

Over/Under 
Threshold

Marker

Short-Term (S) /
Integrated (I)
EBU Display

Loudness Range
EBU Display

5.1-Ch PPM
Thumbnail

Momentary LUFS/
LKFS Bar Graph

Graphing Format displays a running graph spanning from real-time to a selectable “look-back” interval showing a history of loudness. 

This format is unique in that it offers a detailed trend analysis of aggregate loudness over a selectable time span. When EBU R 128 
measurement modes are selected, this format also displays full real-time EBU R 128 M (momentary) measurement values.

Item Function
Format Select Control Rotating this knob toggles the left display between Graphing Format described here and Real-Time Bar 

Graph Format described on previous page.

Mode Select Control/
Display

In graphing format, selects from the four following measurement standards:

• EBU R 128 “+18 Scale” • EBU R 128 “+9 Scale”
• ATSC A/85 (ATSC -24) • Custom (configurable target LKFS and measurement parameters)

Refer to Audio Loudness Meter Measurement Modes (p. 3-2) for detailed mode descriptions and 
parametric settings.

Note: Mode Select can only be performed in the Graphing display format described here.

Origin and Look-Back 
Span Select Control

Real-time plot starts at right side of window, with earlier data expanding to the left. Rotating Span 
control selects from multiple span window widths from 45 sec to 25 hr, 46 min.

Short-Term Avg 
(average) Plot

Solid trace shows EBU R 128 or ATSC A/85 short-term (3 sec) loudness value.
This plot is continuously drawn regardless of whether or not a session is running, paused, or stopped.

Over/Under 
Threshold Marker

Vertical band width shows red for intervals where user-configured HI threshold has been exceeded. 
Band shows blue for intervals where user-when configured LO threshold has been exceeded.

Short-Term Min/Max 
LKFS Envelop

Gray envelop shows minimum and maximum short-term LKFS values occurring within consecutive 100 
msec measurement sampling intervals.

Short-Term (S) and 
Integrated (I) EBU 
Display

Short Term displays running short-term (S; 3-sec) value regardless if session is in progress.
Integrated displays the running session Integrated (I) value and functions only while session is in 
progress.

Loudness Range 
(LRA) Display

Displays EBU LRA value (with highest and lowest values dropped) updated for each 3-sec interval. This 
is active only while a session is in progress.

Momentary LUFS/
LKFS Bar Graph

Shows momentary (EBU R 128 “M” 400 msec value or A/85 400 msec value). Color-coded segments 
indicate over-threshold (red), within (green), and under-threshold (blue). Axis to left of display also 
correlates to plotted graph.

5.1-Channel PPM 
Confidence 
Thumbnail

Shows basic confidence display of dynamic levels on the 5.1-channel complement selected for audio 
metering.

Mode Select
Control

Span Select
Control

Format Select 
Control

Mode Display
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Operating Instructions Audio Meter Displays
Session Control (Right) Display

(See Figure 3-4) The right display consists of the typical controls used to run 
a session, as well as displays related to a running session and post-session 
assessments.

Figure 3-4  Session Control Right Display

Session Operator Controls

Session Program Material 
Timecode Display

Session Loudness Display

Session On-Screen
Error Log

Item Function

Session Operator 
Controls

Session START, STOP, and PAUSE buttons. Individual button is highlighted when activated. After 
session is stopped, holding the STOP button for 3 seconds clears the session display.

Session Loudness 
Display

When the STOP button is pressed, the final session loudness value is displayed and held. At the end 
of a session, it shows the session-duration value over the course of the entire session (excepting any 
intervals when pause was effected). End of session assessment is denoted by white, blue, or red 
characters indicating OK, LO, or HI. 

Note: Units displayed are a function of selected mode.

Session Program 
Material Timecode 
Display

When received from the host card, displays running timecode of program material. Timecode data 
updates regardless of whether session is in progress. This can be used in cueing material directly using 
the Control Panel.

Session Elapsed Time 
Display

While session is in progress, displays session elapsed time in hr:min:sec:tenths. 
If PAUSE is pressed, this display freezes. All log entries for a particular session use session elapsed 
time values in flagging the occurrence of events (such as HI threshold events).

Session On-Screen
Error Log

During the course of a session, a color-keyed error log is displayed which is updated per short-term 
sample intervals. If PAUSE is pressed, this display holds any statistics and is then is updated as 
required when the session resumes. 

Session Elapsed 
Time Display

User-configured error thresholds determine error flagging for log.

With Show Max Error selected, only maximum error during the 
course of a session is displayed and logged.

With Show Max Value selected, maximum values (including 
errors and valid conditions) during the course of a session are 
displayed and logged.
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3 Setting Up the Audio Loudness Meter
Setting Up the Audio Loudness Meter
Setup of the loudness meter for most applications can be accomplished using 
the Basic Setup Using Default Modes instructions below. Measurement 
conforming to current standards is accomplished as described in Basic 
Setup Using Default Modes below.

For advanced features such as customized loudness measurement parameter 
settings and event-triggered automation (such as level and timecode triggered 
session start/stop), refer to Advanced Meter Setup (p. 3-8) after performing 
Basic Setup described below.

Basic Setup Using Default Modes

Basic setup using default modes means setting up the meter to measure 
loudness using any of the pre-defined measurement modes (EBU +9, 
EBU +18, or ATSC -24) to conduct measurements and sessions in accordance 
to standards EBU R 128 “+9 Scale”, EBU R 128 “+18 Scale”, or ATSC A/85, 
respectively. For these modes, perform the following in accordance with 
instructions provided:

• Assigning Input Channels to Meters

• Configuring Alert Thresholds and Display Units

Assigning Input Channels to Meters

(See Figure 3-5) Input channels assignment to the loudness meter inputs are 
done through DashBoard™. 

Figure 3-5  Assigning Input Channels to Meters

Note: Audio loudness meter may have a Channel selection submenu. This has 
been superseded with the DashBoard channel selection described above.

In DashBoard, select the Loudness Metering tab and set drop-down selections to direct the desired channels to the loudness meter. 
Host cards that support pre/post loudness metering have a Meter 1 field (which correlates pre-processed channels assignments to the 
Pre-Processed loudness meter 1) and a Meter 2 field (which correlates post-processed channels assignments to the Post-Processed 
loudness meter 2).

In this example, upmixed 5.1-channel complement is directed to the Pre-Proc loudness meter 1, and upmixed>loudness processed 
5.1-channel is directed to the Post-Proc loudness meter 2.
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Operating Instructions Setting Up the Audio Loudness Meter
Configuring Alert Thresholds and Display Units

Note: The error threshold settings below affect only user configurable error flagging 
in displays and logs furnished by the Audio Loudness Meter (for example, 
LKFS HI and LKFS LO errors). These threshold settings are wholly indepen-
dent of the LUFS/LKFS measurement function. In gated modes such as 
EBU R128, LO errors are largely immaterial in that these events are rejected 
from the integrated/session LUFS by the gating function.

1. Press the Select Device key and select 0 This Control Panel.

2. Select submenu 1 Loudness PPM Settings.

3. In the eight-segment control screen that appears, press on the adjacent 
knob to open selection dialogs and perform settings for the following:

Configuration Item Description
Default 
Setting

• Channel Meters Sets input channel dB PPM meters to 
display either:

• Absolute (dBFS)
• Relative dB units

Absolute

• Level Scaling For Relative units display mode, sets 
dBFS level that correspondingly results 
in a 0 dB (rel) level displayed on PPM 
meters.

-20 dBFS

• Peak Threshold Sets level (in dBFS) at which
channel input level ≥ Peak Threshold setting

results in Peak Error indication.

-1.0 dBFS

• VU Red Sets the level at which
channel input level ≥ VU Red setting 
results in red bar segment displayed on 
channel PPM meters.

-10 dBFS

• VU Yellow Sets the level at which
channel input level ≥ VU Yellow setting 
results in yellow bar segment displayed 
on channel PPM meters.

-20 dBFS

• Short-term LUFS/
LKFS Bar Display 
Response

Sets the response and measurement 
display interval of the LKFS Short 
Term bar graph display to either 
moving-average calculated response, 
or 1-second fast response mode. 

• Moving Average – Display 
response using user-configured 
Moving Average Period setting.

• 1 Second Average – Display 
response using 1-second response 
update.

Moving 
Average

• Report Channels In generated reports, limits reporting of 
just L/R channels, or no limits and 
includes all channels

All channels

• Max. Error/Max. 
Value Display 

Sets the on-screen event log to tabulate 
and display either maximum error or 
maximum value attained while a 
session is running. (See Figure 3-4 on 
page 3-5 for more information)

Shows Max 
Error
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3 Setting Up the Audio Loudness Meter
4. Press the Select Submenu key and select 3 Loudness Thresholds.

5. In the eight-segment control screen that appears, press on the adjacent 
knob to open selection dialogs and perform settings for the following:

6. Press the Select Device key and select desired audio loudness meter.

7. Depending on whether or not advanced settings are desired, proceed as 
follows:

• If advanced features such as custom loudness measurement 
parametric settings or automated start/stop are desired, go to 
Advanced Meter Setup (p. 3-8).

• If sessions are now to be performed without advanced features, go to 
Session Setup (p. 3-16).

Advanced Meter Setup

Customizing Loudness Parametric Settings

Note: Custom mode configured with user settings may not be compliant with 
EBU R 128 or ATSC A/85 standards. Read and understand Appendix A, 
“Loudness Measurement Guidelines and Techniques” in this supplement and 
published standards before considering using customized settings.

Individual parameters related to multi-channel loudness measurement can be 
customized using the Loudness Custom Mode Settings submenu. When a 
session is then to be run, the Custom measurement can be selected to use the 
customized loudness measurement model.

1. Press the Select Device key and select 0 This Control Panel.

2. Select submenu 2 Loudness Custom Mode Settings.

Configuration Item Description
Default 
Setting

• HI Error Threshold Sets maximum offset above LUFS/
LKFS target level, where exceeded, 
results in an LKFS violation for the 
duration of the event.

+4.0 LU 
above target

• LO Error Threshold Sets minimum offset below LUFS/
LKFS target level, where exceeded, 
results in an LKFS violation for the 
duration of the event. This condition 
results in a violation regardless of the 
duration of the event.

Disabled
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Operating Instructions Setting Up the Audio Loudness Meter
3. In the eight-segment control screen that appears, press on the adjacent 
knob to open selection dialogs and perform settings for the following:

Signal-Level Triggering

Note: Signal-level triggering can be used with any of the standard measurement 
modes or the Custom mode.

(See Figure 3-6.) Signal-level triggering can be enabled and configured in 
which actual session start and stop is triggered by assessing input signal 
levels. In this mode, the Audio Loudness Meter does not start session 
measurements and calculations until at least one of the configured input 
channels exhibits a level exceeding a configurable minimum threshold. When 
a detected level exceeding the Trigger Threshold setting is received, the 
session starts. In this mode, when an operator presses the START button, 
Waiting is displayed until the threshold is crossed, and then Running is 
displayed, indicating level-triggered start. Session stop is also automatically 
activated using this mode. 

Configuration Item Description
Default 
Setting

• Target LKFS/LUFS Sets the user-configurable target LKFS/
LUFS value.
(range = 0 to -60 LKFS)

Note: In EBU modes, this setting sets 
the “0 LU” target value.

-24 LKFS/
LUFS

• Absolute/Relative When set to Absolute, shows absolute 
units on short-term and session LKFS/
LUFS displays, as well as in reports.

When set to Relative, shows units 
relative to configured Target LKFS/
LUFS value. Units on short-term and 
session LKFS/LUFS display as relative 
(LU), as well as in reports.

Absolute

• Viewable Range For instantaneous bar graph display 
and accompanying plot in EBU/ATSC 
Graphing format, selects from:

• 27 LU – Sets bar graph/plot to EBU 
“+9 Scale” (+9 to -18 LU scale).

• 54 LU – Sets bar graph/plot to EBU 
“+18 Scale” (+18 to -36 LU scale).

27 LU

• Moving Average 
Period

Sets the duration (in seconds) that 
sampling time accumulates before each 
averaging recalculation of measured 
LKFS.
(range = 1 to 60 sec)

3 sec

• Use EBU Relative 
Gating

Enables or disables low-level rejection 
gating 

Disabled

• Relative Gating 
Threshold

When gating is enabled as per above, 
selects the threshold at which levels 
equal or below are rejected (gated from) 
measurement calculations.
(range = -8 LU; -10 LU)

-8 LU

• Units Select either LKFS or LUFS units. LKFS
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3 Setting Up the Audio Loudness Meter
Figure 3-6  Signal-Level Triggering

Set up signal level triggering as described below.

1. Press the Select Device key and select 0 This Control Panel.

2. Select submenu 4 Loudness Meter Automated Triggering.

3. In Automated Triggering submenu, select Signal.

4. In the eight-segment control screen that appears, press on the adjacent 
knob to open selection dialogs and perform settings for the following:

t

Trigger
Threshold
(in dBFS)

Operator presses 
START button

Actual signal-triggered 
session start

Auto-stop (STOP displayed 
on panel)

Data within this interval is automat-
ically discarded, with any effect on 
session totals recalculated

Actual signal-triggered 
session stop

Configuration Item Description
Default 
Setting

• Start Trigger 
Threshold

With signal-based triggering enabled 
and START button pressed, session 
measurements and calculations do not 
start until at least one of the received 
channels exhibit a level exceeding the 
Start Trigger Threshold setting. 
(range = 0 to -60 dBFS)

-60 dBFS

• Stop Trigger 
Threshold

With signal-based triggering enabled 
and session running, when all of the 
received channels exhibit a level less 
than the Stop Trigger Threshold setting, 
the session stops automatically. 
(range = 0 to -60 dBFS)

-60 dBFS

• Stop Trigger 
Duration

Sets time following point where LKFS 
session automatically stops. Session 
LKFS numerical value is recalculated to 
discard any data after stop trigger 
threshold is crossed. 

5 seconds
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Timecode Triggering

Timecode triggering can be enabled and configured in which actual session 
start and stop is triggered using timecode values received and reported by the 
host card. In this mode, the Audio Loudness Meter does not start session 
measurements and calculations until the Start Trigger Timecode value is 
received. In this mode, when an operator presses the START button, Waiting 
is displayed until the timecode value is received, and then Running is 
displayed, indicating a triggered start. Session stop is also automatically 
activated using this mode. 

Set up timecode triggering as described below.

1. Press the Select Device key and select 0 This Control Panel.

2. Select submenu 4 Loudness Meter Automated Triggering.

3. In Automated Triggering submenu, select Timecode.

4. In the eight-segment control screen that appears, press on the adjacent 
knob to open selection dialogs and perform settings for the following:

Note: Audio loudness meter may have a Control > Timecode selection submenu. 
This has been superseded with the DashBoard outputted timecode. The 
audio loudness meter uses the timecode format displayed on the host card 
Timecode > Output Status display.

Configuration Item Description
Default 
Setting

• Start Trigger 
Timecode

With timecode-based triggering 
enabled and START button pressed, 
session measurements and calculations 
do not start until entered start timecode 
value is received. 
(entered in hh:mm:ss)

No default 
setting

• Stop Trigger 
Timecode

With timecode-based triggering 
enabled and session running, when 
stop timecode value is received, the 
session stops automatically. 
(entered in hh:mm:ss)

No default 
setting

• Stop Trigger 
Duration

Sets time following point where LKFS 
session automatically stops. Session 
LKFS numerical value is recalculated to 
discard any data after stop trigger 
threshold is crossed. 

5 seconds
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Automated Session Rollover (Daily Restart)

(See Figure 3-7.) Sessions can be set to stop (wrap-up and close session) and 
then immediately restart (start a new session) at a specified time within the 
24-hour day. This allows for very orderly, consistent reports that are automat-
ically generated on a daily basis, with each report subsequently having identi-
cal start /stop times and durations (see Post-Session Reports (p. 3-18) for 
more information about generated reports). The session rollover is fully auto-
matic with no intervention required.

Figure 3-7 shows an example with rollover enabled for 11:30 PM (23:30:00) 
that will automatically produce daily (24-hour) reports at 11:30 PM.

Figure 3-7  Session Rollover Function and Example Reports

Note: Rollover triggering requires that a session be in progress and running before 
a rollover stop and start can occur. If a session is in cue but waiting due to 
timecode or signal-level triggering enabled without conditions to start a 
session, rollover will not occur because there is no preceding session to 
rollover.

Use care when considering using rollover triggering in conjunction with 
timecode or signal-level triggering. It is recommended that timecode 
triggering not be used in conjunction with rollover triggering.

Set up session automatic rollover stop/start as described below.

1. Press the Select Device key and select 0 This Control Panel.

2. Select submenu 4 Loudness Meter Automated Triggering.

Session

23
:3

0:
00

Nov 
8, 

20
11

23:30:00 rollover results in automatic 
cessation of Nov 8, 2011 (2011-11-08) 
session @ 23:30:00 with html and csv 
reports being correspondingly generated.

Time of Day,
Date

23
:3

0:
00

Nov 
9, 

20
11

Auto-Rollover 
Session (Nov 9)

Auto-Rollover 
Session (Nov 10)

Auto-start of new session
(for Nov 9, 2011)

23:30:00 rollover again results in 
automatic cessation of Nov 9, 2011 
(2011-11-09) session @ 23:30:00 
with html and csv reports being 
correspondingly generated again for 
Nov 9, 2011.

Auto-start of new session
(for Nov 10, 2011)
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Operating Instructions Setting Up the Audio Loudness Meter
3. In the Session Rollover time field, enter the time of day (in military 
time) in which the rollover session start/stop should occur.

4. Set Enable Session Rollover to Enabled. 

5. Start a session and let it run. When the entered session rollover time 
occurs, the running session will automatically stopped (with its report 
being generated upon cessation) and a new session will automatically 
start. This cycle will continue indefinitely unless the Enable Session 
Rollover control is set to disabled.

Note: • OGCP-9000 has limited device memory (as compared to memory available 
on a computer). If daily rollover is used, it is recommended to save the ses-
sion data off of the control panel, and then delete the on-device sessions to 
free-up memory. This should be performed at least weekly.

• .csv reports are available only on WinOGCP.

Multi-Segment Session Aggregate (Option +SESSION)

Note: Option +SESSION is an option that is added to Loudness Metering +LM and 
is available only for WinOGCP.

Licensable feature +SESSION allows an Aggregate Session, in which a 
session is run in segments (for example several segments over several days), 
with each new segment joined with previous segments to comprise an 
aggregate session at the conclusion. Using this feature, when a session is run, 
it can be paused and its data saved in a .ses file. WinOGCP can be exited 
indefinitely. When ready to continue on with another session segment (for 
example again, on the next day), WinOGCP can be opened again and the 
saved .ses file then loaded. When loaded, WinOGCP will be ready to start a 
session again while taking in this data as part of a subsequent session. 

After finally closing an aggregate session, a single file set of .html and .csv 
reports are generated showing:

• the total session run time of all unpaused segments, and

• the aggregate LKFS of all unpaused session segments. 

In this manner, a single report is availed that is identical as if all the segments 
were run in a continuous, uninterrupted session. Contact Cobalt Support to 
expedite obtaining a license key for WinOGCP. (As with all licensable 
features, the license is a purchased item and is applicable on a per-panel 
basis.)

Use this feature as described below and shown in the Figure 3-8 example.

1. Run the first segment of a session by pressing RUN.

2. When the first segment is completed, press PAUSE.
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3 Setting Up the Audio Loudness Meter
3. At this point, WinOGCP is ready to download this segment’s data. 

• In WinOGCP tool bar, click Session and select Save Session State.

• In the browser that appears, save the .ses file and close WinOGCP.

4. When ready to resume with another session segment, open WinOGCP 
and upload the .ses file:

• In WinOGCP tool bar, click Session and select Load Session State.

• In the browser that appears, browse to and select the saved .ses file.

5. WinOGCP now displays PAUSED, along with the Session LKFS and 
session running time left over from the previous segment. Start a new 
segment by pressing RUN.

6. When this segment is done, depending on whether another segment will 
be run (or the overall session is to be concluded) proceed as follows:

• To set up to save for more segmented sessions – Press RUN to run 
another segment and then press PAUSE at the end of segment. Repeat 
steps 3 thru 5 to save the session data. The .ses file now reflects data 
from this segment and any other aggregated segments using this 
feature. Press RUN again to perform another segment and repeat 
these steps.

• To conclude the overall aggregate session – At end of last segment, 
simply press STOP. This wraps up the overall session. At this point, 
WinOGCP displays the final aggregate LKFS Session value and final 
session elapsed time. Also at this point just like a regular 
unsegmented session, both html and cvs reports are generated, with 
the reports reflecting aggregate LKFS and time stamps just like 
regular reports.

Note: +SESSION option generates intermediate .html and .csv files in the same 
folder where the .ses is saved. Do not use these report files; the consolidated 
aggregate reports are available as normal using the WinOGCP tool bar and 
going to View > Report Directory. (These intermediate files can be deleted 
after an aggregate session is concluded if desired.)
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Figure 3-8  Example Flow Using +SESSION Multi-Segment Aggregate Session

First
Segment

Ses
sio

n P
au

se

First segment of session is run and then PAUSE is 
pressed at end of segment (in this example, a 
7-hour session yielding a session LKFS of -24.4).

Second
Segment

Session segment is downloaded to host 
PC by clicking Session > Save Session 
State. (In this example, 
“ses1-1-31-13.ses” is saved to My 
Documents.)

WinOGCP can now be closed. The 
previous segment’s data is saved in 
“ses1-1-31-13.ses” in this example.

WinOGCP is opened on next day. WinOGCP data 
from previous day is uploaded by clicking Session > 
Load Session State and selecting the .ses file (in this 
example, “ses1-1-31-13.ses”).

WinOGCP shows PAUSE, with session LKFS and 
time reflecting that from previous segment.

Press RUN to continue with aggregate session.

Second segment is now run by pressing RUN and 
then stopped or paused at end of segment.

The aggregate for the overall session is reported on 
WinOGCP and in a single, consolidated report (in this 
example yielding an 11-hour aggregate session and 
a -22.5 LKFS aggregate LKFS).

1

2

3
4

5

6
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3 Session Setup
Session Setup

Pre/Post Metering Shortcut

Just like other card control displays on the Control Panel, functions tied to 
specific cards are invoked by selecting a particular Device. Typically, a 
Control Panel set up for Loudness Metering has Device 1 as the pre-loudness 
processed meter and Device 2 as the post-loudness processed meter.

When the panel is set to display any of its devices, pressing the corresponding 
shortcut key on the keypad invokes the desired meter without having to go 
through the Select Device menu.

Figure 3-9  Loudness Meter Shortcuts

Note: • Loudness meter(s) on your Control Panel may have different Device num-
ber(s) than shown in this example. The number entered on the shortcut is 
the same as the device number displayed under the Select Device menu.

• Only Fusion3G® cards support pre-loudness processing measurement

Running a Session

Table 3-2 lists and describes the typical steps and Audio Loudness Meter 
interaction performed by a QC operator in using the Audio Loudness Meter to 
assess program material.

Pressing 1 invokes 
pre-loudness processing 

Meter 1

Pressing 2 invokes 
post-loudness processing 

Meter 2

Meter name is displayed 
here (in this example, 
“Post-LP Ingest 1B”)

Table 3-2 Typical Operator Workflow Using the Audio Loudness Meter

Task Description

Select desired 
measurement mode

Before starting a session, make certain the intended measurement mode (EBU +9, 
EBU +18, ATSC -24, or Custom) is selected using Mode Select Control as shown in 
Figure 3-3 on page 3-4.

Cue program material 
before start of material

Cued before start of material content, the operator should cue the material and be ready 
to start the session using the meter.
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Operating Instructions Session Setup
Roll material and start 
session

With material rolling, immediately after cue tone or 0-count marker, session should be 
started by pressing the meter START button.

Note: Enabling and configuring the Signal-Level or Timecode Triggering feature helps 
circumvent operator error for this step.

Observe meter input levels 
and error log displays

The operator should make certain all intended channels are reporting audio levels. The 
operator should also monitor the ERROR TYPE log on the Control Panel right-side 
display panel. With appropriate guidance, an operator can be trained to immediately 
detect and reject material logging excessive errors, thereby not unnecessarily spending 
time on a severely flawed piece.

For LKFS input channels (L, R, C, Ls, Rs), whenever the Short-Term LKFS display 
shows a HI error, individual channel heading changes to red for channel(s) most likely 
contributing to the overall HI LKFS error (in this example, the Rs channel).

Note: Individual channel errors displayed for an aggregate LKFS HI error are always the 
channels observed most likely to be contributing to the overall error. However, 
when considering correction for offending channel(s), make sure intended 
production aesthetics for the mix have been considered. (For example, if a 
channel containing dialog contributed to a HI error but requires its current level 
balance respective to other channels, consider proportional reduction of all 
channel levels.)

(ATSC -24 Mode Only) 
Use the PAUSE button to 
exclude dramatic silence in 
material from session

If the material contains significant amounts of intended silence or very low audio levels 
(for example, long periods without dialog or music), the PAUSE button allows rejection 
of these intervals from measurement, thereby resulting in a more representative 
assessment of actual LKFS.

Press the STOP button 
immediately after end of 
material content

Immediately after end of material content, session should be stopped by pressing the 
meter STOP button.

Note: Enabling and configuring the Signal-Level or Timecode Triggering feature helps 
circumvent operator error for this step.

Expedite per meter 
assessment

The meter provides unambiguous assessment of program material per configured 
parameters when a session is performed noting the techniques described above. The 
assessment is shown in the SESSION display on the right display panel. Expediting 
passed or failed material should be handled per your procedures and practices.

Table 3-2 Typical Operator Workflow Using the Audio Loudness Meter — continued

Task Description
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Post-Session Reports
Session data can be reviewed and archived using a Session Report utility and 
by using the Loudness Meter Data .csv output utility as described below/

Loudness Meter Session Reports (OGCP-9000)

Figure 3-11 shows an example of a web post-session report, which can be 
accessed and displayed via a web browser pointing to the Control Panel IP 
address. The report can be manipulated just as any other web page (i.e., used 
for copy/paste, printed, or saved as a file). 

Note: • If a report for a session is to be saved, it should be performed before 
another session is run. Conducting another session without downloading the 
report will result in loss of present report.

• .csv reports are not available on OGCP-9000.

Access a session report as follows:

1. Open a browser window and enter the Control Panel IP address on a 
computer connected to the frame LAN (“192.168.0.57” in the example 
shown below).

2. When the screen shown below appears on the computer, click on
Loudness Meter Session Report to display the web screen of the session.

Note: Some computers use web browsers that cache web content. Therefore, the 
displayed report web page may initially not be current. Check the displayed 
report Session Duration versus that displayed on Control Panel. 

If the report appears not to be current, on the computer hold CNTRL key and 
press the refresh button to obtain current (non-cached) report.
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Loudness Meter Session Reports (WinOGCP)

Figures 3-10 thru 3-12 show the WinOGCP Report Directory and examples of 
web and .csv post-session reports. The report can be manipulated just as any 
other web page (i.e., used for copy/paste, printed, or saved as a file). 

Access a session report by clicking View > Report Directory. A browser 
opens as shown in the example below. Companion web and .csv reports are 
listed in chronological order.

Figure 3-10  WinOGCP Report Directory

Card slot

Loudness Meter name
(in this example, card 
Loudness Meter 2 named 
“Post LP Ingest 1B” Date (YYYY-MM-DD)

Time (session start; in 
military time)
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3 Post-Session Reports
Figure 3-11  Example Post-Session html Report

Session particulars, including general 
session info and channels monitored

Session target LKFS and thresholds

Session automatically assessed 
recommendation

Detailed error log showing each logged 
error, including time stamp, duration, 
and type of error along with potentially 
offending root channels
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Figure 3-12  Example Loudness Meter .csv Data Report

Session particulars, 
including general 
session info, target/
threshold settings, 
and channels 
monitored

0.5-second 
updated total 
short-term LKFS 
and individual 
channel LKFS 
levels (LKFS 
channels) and 
peak dBFS (all 
monitored 
channels)

Error flags for 
segments
exceeding
thresholds

• • •
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Troubleshooting
Because the Audio Loudness Meter option is installed on a currently 
up-and-running Control Panel and host card, installation is very 
straightforward with typically no changes being performed on the Control 
Panel and host card other than installation and configuration of this option. 
Therefore, common basic checks and general/network troubleshooting 
information referring specifically to the Control Panel and host card and its 
frame are not duplicated here; these items should be checked as applicable. If 
the Control Panel or functions in this option do not seem to be responding, 
always first check network connectivity of the host card frame and Control 
Panel in accordance with the Troubleshooting sections of the manuals listed 
below.

• Refer to Product Manual that came with your OGCP-9000 or 
WinOGCP Control Panel for Control Panel troubleshooting 
information (including network troubleshooting).

• Refer to Reference Guide “Remote Control User Guide” (PN 
9000RCS-RM) for networked frame troubleshooting information.

• Refer to the Product Manual for the host card for card operating, 
signal validity checks, and network connectivity checks.

Errors or unusual operation of this option are typically related to one or more 
parameters not being set as expected or required. Information to help isolate 
these type of errors is provided below.

Table 3-3 Troubleshooting Processing Errors by Symptom

Symptom Error/Condition Corrective Action

Control does not respond to 
changed settings

Lock icon indicates 
changes cannot be made at 
this time. This is typically 
displayed if changes are 
attempted while a session is 
running.

Stop session, then change setting.

No Data displayed on Control 
Panel.

Host card associated with 
Control Panel/Audio Loudness 
Meter option not receiving 
intended video/audio signal.

Using the Control Panel, DashBoard™ or card 
edge indicators, make certain host card is 
receiving intended signal (for example, if 
embedded channels are being fed to the Audio 
Loudness Meter, make certain SDI input is 
present and card DashBoard Audio Input 
Controls tab shows audio present for intended 
channels).
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No IP Connection 
displayed on Control Panel.

Frame with host card (target 
frame) not visible to Control 
Panel.

Make certain intended target frame is properly 
connected to network.

Note: Host card frame must be set for static IP 
address. If set for DHCP, address change 
will not be recognized by Audio Loudness 
Meter configuration file.

No Card in Slot displayed 
on Control Panel.

Host card(s) not present or in 
wrong slot/frame.

Make certain host card(s) is in frame /slot 
location as specified in Control Panel Audio 
Loudness Meter option configuration file. 

Note: Host card frame must be set for static IP 
address. If set for DHCP, address change 
will not be recognized by Audio Loudness 
Meter configuration file.

Feature Missing displayed 
on Control Panel.

Audio Loudness Meter feature 
option is not activated on host 
card(s) selected by the Control 
Panel Audio Loudness Meter 
option configuration file. 

The host card selected by the configuration file 
must have the Audio Loudness Meter feature 
activated in order for the card to report data to 
the Control Panel. 

Make certain designated card has this feature 
activated. Check for presence of the feature in 
DashBoard™ by going to the Licensable 
Features tab; the feature is indicated by 
Audio Metering appearing in this pane when 
the tab is selected.

Note: Audio Loudness Meter feature resides in 
the host card. If the card is replaced (even 
with a same-model card), the feature 
requires reactivation in the replacement 
card before it can provide the feature.

Channel input level not being 
displayed on PPM meters.

Channels not routed on Control 
Panel as expected.

Check channel routing as described in Setting 
Up the Audio Loudness Meter (p. 3-6).

Session will not start Automated triggering 
erroneously engaged

If automated triggering (signal-level or timecode 
based) is not intended, make certain 
Automated Triggering is set to Disabled.

(menu):  0 This Control Panel > 
(submenu): 4 Loudness Meter Automated Triggering > 

 - Disabled

Table 3-3 Troubleshooting Processing Errors by Symptom — continued

Symptom Error/Condition Corrective Action
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3 Troubleshooting
Unusually high amount of 
channel level errors (overpeak or 
LKFS HI).

• Channel meter thresholds 
improperly set

• Make certain parameters are set as intended.

• Unused inputs may have 
signal level present

• Make certain all meter input channels are 
either routed to intended channels or set to 
Silence for unused channels.

Note: Do not use analog or Dolby input channel 
setting for unused channels. These 
inputs cannot be assured of full muting 
with an unused or open input.

• Undecoded Dolby® E or 
AC-3 channels routed to 
Audio Loudness Meter input 
channel

• Encoded Dolby E or AC-3 data cannot be 
directly applied to an input channel. Encoded 
Dolby E or AC-3 data require a host card 
having the Dolby Decoder option (-DEC). 
Decoded channels can then be routed to the 
Audio Loudness Meter input channels. 

Timecode not present (or shows
? (question mark))

• Timecode selection on Audio 
Loudness Meter not 
compatible or not correctly 
set for timecode supported 
by host card.

• Make certain parameters are set as intended. 
Check as described in Timecode Triggering 
(p. 3-11). 

• Host card not receiving 
intended timecode format

• Using DashBoard, Control Panel or card edge 
controls, check host card Timecode display. 
Make certain intended timecode format is 
available and shown as Locked.

Table 3-3 Troubleshooting Processing Errors by Symptom — continued

Symptom Error/Condition Corrective Action
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Appendix A
Chapter 1   Loudness Measurement
Guidelines and Techniques

Note: The EBU +9, EBU +18, and ATSC -24 modes are factory configured with all 
parameters conforming to the respective standards and are ready for immedi-
ate use. This information is supplemental and for general information only. 
Read and understand applicable standards and this appendix if intending to 
use the meter Custom mode.

This appendix provides a condensed guide to practical techniques for using 
the Audio Loudness Meter to properly measure and assess loudness in various 
types of program material.

The content here is in general accordance with ATSC A/85, “ATSC 
Recommended Practice: Techniques for Establishing and Maintaining Audio 
Loudness for Digital Television”. This document is available free of charge 
and can be downloaded by going to:

http://www.atsc.org/standards/practices.php

About Loudness Measurement Applied to Program Material
A very useful aspect of the loudness measurement model is that a target and a 
measured end-assessment are based upon simple, single-value LKFS 
measurements that can be unambiguously displayed and assessed. 
(Additionally, the Audio Loudness Meter can provide a simple pass or fail 
result for the piece based on the target and thresholds configured for the target 
LKFS value.) When properly performed as described in this appendix, the 
LKFS measurement model accommodates reasonable short-term loudness 
variations in most types of professionally produced material without nuisance 
failure indications or ambiguous results.

The loudness measurement model specified in ATSC A/85 uses the LKFS 
loudness unit to provide the simple, single-unit value that can be used to 
assess program material loudness. This measurement is obtained by running a 
loudness session on the program material being assessed. Basically, before an 
assessment can be performed, two important initial facets must be considered:

• Target LKFS Value – Using the Audio Loudness Meter, this is the 
desired reading that is to be obtained following the session for a given 
segment or piece of program material. Determining the target LKFS 
value is described in detail below.
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Appendix A Determining Target LKFS Value
• Measurement Technique – Before running a session on the material, 
consideration should be given in using techniques that result in the 
most meaningful or representative LKFS value for the session. These 
techniques are described below, along with techniques suggestions 
suitable for various types of program material.

Determining Target LKFS Value
(See Figure A-1.) Adherence to a target LKFS value across various program 
material (typically from any number of individual, diverse sources) relieves 
viewers from having to constantly adjust program volume at their homes in 
order to maintain an overall comfortable, desired loudness level. General 
guidelines for determining a target LKFS value are as follows:

• Unless specified by a metadata dialnorm value or some other 
specified guidance, target LKFS should be at or about -24 ±2.0 LKFS 
(that of the typical dialnorm value) across any portion of program 
material containing any appreciable audio content (anything other 
than dramatically or aesthetically intentional silence).

• Because the LKFS unit of measure is directly derived from the 
decibel, a gain change of a given amount modifies measured LKFS 
by the same amount. For example, material exhibiting an LKFS of 
-12 LKFS can be made to match that of material exhibiting a 
-24 LKFS level by reducing the overall level at the source by 12 dB.

• Where local content is to be added to a network-supplied feed (e.g., 
local commercial insertion, PSA, etc.), care should be taken that the 
LKFS level of local content matches that of the LKFS level of 
network content.

• Dynamic Range Control (DRC) control/management systems by 
themselves cannot unconditionally be relied upon to assure proper 
LKFS compliance. Many DRC systems use measurement/control 
schemes that do not reflect perceived loudness. A system specified to 
use energy measurement/assessment models reflecting perceived 
loudness, such as the Cobalt® OPT-SW-LP Loudness Processing 
option (licensed from Linear Acoustic™), can reliably provide DRC 
to achieve LKFS compliance. 

Figure A-1 shows an example of measuring LKFS for an ingest piece and 
using the result to assess and remedy the loudness variation between the piece 
and a network feed.

In addition to setting a target LKFS value, the Audio Loudness Meter 
provides means to set thresholds above and below a target LKFS value in 
which an LKFS HI or LKFS LO error is indicated to a QC operator. These 
configurable parameters are described in detail in “Post-Session Reports” in 
Chapter 3,“Operating Instructions”.
A-2 AUDIO LOUDNESS METER OPTION (+LM-C, +LM-P) MANUAL SUPPLEMENT OPT-SW-LM-MS (V2.9)



Appendix A Measurement Techniques For Various Program Material Forms
Figure A-1  Balancing LKFS Across Different Material Sources

Measurement Techniques For Various Program Material Forms
Because of the sometimes intentional broad variance of overall levels and 
audio density in various types of program material, consideration must be 
given in applying techniques that concentrate only on meaningful segments 
within a piece where representative LKFS results can be obtained. Currently, 
a fully automated means of accurately assessing session LKFS for all cases or 
forms of material has not been specified in ATSC A/85. Therefore, techniques 
appropriate for the material must be applied. This section provides guidance 
and examples of properly applied techniques for various cases and forms of 
typical program material.
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Feed Local Insertion Feed

Local insertion ingest without consideration 
of LKFS results in 6 dB difference from feed 
and insertion levels. Viewer is required to 
reduce volume to maintain desired level.

Feed 
LKFS

0

L
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-24
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Feed Local Insertion Feed

By monitoring LKFS of local insertion ingest 
and noting -18 LKFS measured result (vs. 
target -24 LKFS of target/feed), 6 dB 
attenuation of local insertion piece maintains 
acceptable loudness balance between feed 
and local insertion.

Run time

Run time
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Importance of an Anchor Element

ATSC A/85 defines an anchor element as the aural element in material that 
serves as the item within a group of sounds that assumes a dominant role and 
is the “center of attention”. For example, in a piece containing relatively 
constant dialog (such as a typical commercial), the mix and creative input 
would typically position this dialog as the predominate or “anchor” element 
in the mix (in terms of both relative level and channel placement). As such, all 
other elements would normally have levels that proportionally track and stay 
well below that of the anchor element. For example, in program material 
consisting of dialog and background sounds or music, the anchor element 
would be dialog with other sounds substantially lower in level. 

Note that in a given piece, the anchor element can change assignment within 
the course of the material (for example, at the end of a commercial where 
score music or a jingle now may assume the role of creative dominance and 
correspondingly become the anchor element).

Assumptions and Conditions For Meaningful LKFS Measurements

Again depending on the material form, meaningful LKFS measurement and 
assessment can be very straightforward or, conversely, require some 
techniques to help ensure a meaningful assessment is obtained. Very 
straightforward assessments can be obtained when the following are present 
and/or observed:

• Typical production aesthetics with typical post-production refinement 
using moderate, controlled compression and aural content density.

• Consistent audio levels in center channel throughout the piece (e.g., 
dialog or music score).

• Dialog (or equivalent) serving as an anchor element.

• Material containing no excessive periods of unusual loudness or 
silence.

• LKFS is intended as a long-term measurement. The shorter the 
averaging period or overall session, the less representative an 
assessment is of a given pice of ingest material. Where feasible, the 
session should run the entire length of the ingest material. If the 
material does not contain an anchor element, the predominate 
element (e.g., featured music or obvious effects) should serve as the 
anchor.

In these cases, the Audio Loudness Meter can be used with its default 
settings, with a session consisting of a simple session start and stop at the start 
and end of program material run.

Figure A-2 shows an example (using a target LKFS of -24.0) where these 
assumptions can be followed, and an example where certain techniques 
should be applied in order to obtain a meaningful LKFS assessment. 
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Figure A-2  LKFS Measurement/Assessment for Various Program Material Forms
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Relatively high density and compression 
results in fairly consistent short-term LKFS, 
leading to a session LKFS that is highly 
representative of the entire piece.

Using the PAUSE function during the intentionally quiet segment (or using a measurement mode that 
uses gating) discludes the segment from LKFS session measurement, thereby providing a session 
LKFS that is representative of loudness-significant portions of the piece. Applying the PAUSE function 
only where appropriate still allows for reasonably long-term sampling across the overall material 
duration.
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Intentionally quiet segment, if included in 
measurement with no consideration of 
technique, leads to a session LKFS that is 
under-representative of the entire piece.

5-minute Nature Show Act with Narrative/Background Music and Creative-Element Near Silence. In this example, predominate narrative dialog in 
the center channel serves as an anchor element, with subordinate elements being music score and ambient soundtrack. However, the piece also contains 
a significantly long segment containing only very low-level ambient soundtrack during a nature close-up sequence. This loudness change is creatively 
intentional and must be maintained. If this segment is included in the session LKFS measurement, it can result in an under-representation of overall 
perceived loudness. If the gain is increased to compensate for this under-represented LKFS, loudness during periods of narrative/music will be 
unacceptably high. As such, proper technique would be to pause the session during the quiet portion (or use a measurement mode that uses gating), and 
resume the session when the intended, representative anchor element re-appears.

60-second Commercial with Dialog and Background Music. In this example, predominate dialog in the center channel serves as an anchor element. 
Because of the relatively compressed and dense audio content, an LKFS session can be started at the start of audio content, allowed to run unabated 
through the course of the material, and then stopped at cessation of audio. The session LKFS reading obtained can reliably be used to apply gain 
adjustment that correspondingly provides loudness correction.
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Specific Measurement Techniques for Various Material Forms

Described below are specific techniques and suggestions for various settings 
and program material which can be assessed using the Audio Loudness Meter.

Live Production. The Audio Loudness Meter can be used in live production 
to guide the mixing operator to maintain audio level at an LKFS reasonably 
close to that of typical post-production LKFS. Where aural activity is 
significant (i.e., some sort of anchor element clearly exists), the short-term 
LKFS reading furnished by the meter provides a good baseline of target 
loudness compliance. Observing LKFS over a 10-second period (appr.) will 
typically suffice. If a sequence appears where an anchor element can be 
foreseen to start and stop at known points (i.e., scripted material), a session 
can be run to arrive at a session LKFS value (which is more representative 
than observing and assessing only short-term LKFS values). 

Note that in this setting, audio may not be always be compressed/limited; very 
wide swings in dynamic range are possible. Again, only segments that are 
realistically viable in terms of content density, anchor element, and level 
amplitude/consistency should be considered for measurement. If continual or 
sustained LKFS HI violations are noted, it may be indicative of an overall 
“hot” level on the channel or overall mix. 

Post-Production. The guidelines for this settings are similar to that used for 
live production, except that a session LKFS measurement (consisting of using 
the session START and STOP functions) can and should be utilized, since 
various segments can be started and stopped by cueing and rolling tape, and 
then stopping tape. Circumventing quiet segments from influencing the 
session can also be effected using the PAUSE function.

Long-Form Finished Material. An LKFS session should be run for as long a 
segment as possible, however restricting a session to representative portion(s) 
within an act. A representative segment should of course contain an anchor 
element or the next reasonable equivalent. Only absent a representative 
anchor element should a session run the unrestricted length of the piece (this 
should be avoided where possible).

Short-Form Finished Material (e.g., “Commercials”). Typically, this 
material will have a clearly discernible anchor element and relatively 
consistent loudness density. As long as the material does not have loudness 
pauses exceeding half the overall run time (which is typically unlikely), a 
simple session run over the course of the material without the pause 
techniques will typically provide a very reliable LKFS result.
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Modifying LKFS Session Assessments Using Parametric Settings

Moving Average Period Setting. (See Figure A-3.) The Moving Average 
Period sets the sampling time accumulated in each averaging recalculation. 
As such, longer periods will include more short-term LKFS “look-back” 
values into the moving average. Because the Moving Average Period affects 
averaging that is used in measuring and calculating the session LKFS result, 
changes in this setting will affect session LKFS numerical results.

Figure A-3  Modifying the Moving Average Period Parameter

LKFS Alert Thresholds. These parameters set the LKFS HI and LO points 
at which the Audio Loudness Meter displays and logs indicate an LKFS error 
to the QC operator. These threshold settings are wholly independent of the 
LKFS measurement function. As such, resulting numerical short-term and 
session LKFS values displayed for a session are not in any way affected by 
these threshold settings. In most cases, the default settings will provide 
reasonable, representative indications of material compliance or rejection 
with the configured target LKFS.

Shorter Moving Average Period produces more 
responsive averaged LKFS reading, with greater 
range variation over the course of sampling.

Longer Moving Average Period produces a more 
representative averaged LKFS reading over the 
course of sampling, with reduced sensitivity to 
short-term LKFS deviations.
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